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Ftrack-Connect


Starting ftrack-connect

Click on the tiny green box in the top panel.

[image: _images/ftrack-connect.png]
If you can’t find it, please contact your TD.

You know ftrack_connect is already running on your machine, if you see the tiny green box
in the application tray on the top right corner of your desktop.

[image: _images/ftrack-running.png]



Stopping ftrack-connect

Right click on the tiny green icon in the application tray on the top right corner of your desktop.
Click on ‘Quit’.

[image: _images/ftrack-quit.png]

Note

When you restart your machine, remember to start ftrack-connect.

When there is a new update to the pipeline, your TD may ask you to restart ftrack-connect.
In such a situation, follow the above instructions to stop and start ftrack-connect.









          

      

      

    

  

    
      
          
            
  
Shot Ingestion


Creating an Ftrack Project

Before you start with the shot ingestion process, make sure the corresponding project exists on Ftrack.
To create an ftrack project, simply go to the ftrack page, click on ‘Projects’ in the top left corner and
click on the “Create new project” button.

[image: _images/proj_create.png]
Now a UI will pop up on your screen.

[image: _images/proj_create_gui.png]
Type in the project name, select the workflow schema and click on ‘Create’.


Note


	Make sure there are no spaces in your project name. Ideally, your project name should be all
lower case. Use an underscore (‘_’) to add a space between words.

	Please select “VFX Scheme” as the workflow schema.





When a project is created on ftrack, the corresponding folder structure in automatically created on disk.

The template folder structure is:

Project Drive: /data/production/<project_name>
<project_drive>/assets
<project_drive>/assets/3d
<project_drive>/assets/artwork
<project_drive>/assets/hdri
<project_drive>/production
<project_drive>/production/approvals
<project_drive>/production/editorial
<project_drive>/production/io
<project_drive>/production/meetings
<project_drive>/production/schedule
<project_drive>/reference
<project_drive>/shots
<project_drive>/template_files








Hiero Workflow

Shot ingestion through hiero is a 2 step process.

First, use the ftrack plugin in hiero to create shots in Ftrack.

[image: _images/ftrack-shots.png]
[image: _images/create_shots_hiero.png]
Second, use heiro to export dpx images and a nuke script to disk.

Right click on the shot in the timeline and select export.

[image: _images/hiero-export.png]
[image: _images/export-shot.png]
When the export window pops up on the screen, select the appropriate preset.

The “export to” path should be <project_dir>/<project_name>/shots
eg. /data/production/ef_coiled/shots

The preset structure should be

[image: _images/export-struct.png]

Note

Don’t worry about creating task folders in heiro. Creating a task in ftrack, will automatically
create a task folder for that shot on disk.



Make sure to select the ‘Loco Nuke Project’ in the ‘Content’ column for the ‘.nk’ file.

[image: _images/export-nuke.png]
Select the appropriate read and write nodes that should be included in the nuke file.

Now click on export. This will export the dpx images as well as the nuke file.




Ftrack workflow

Sometimes creating shots through Heiro may not be an option. In this case, you can batch create shots
in ftrack using the ‘Batch Create’ action.

Navigate to your project folder in ftrack. Click on ‘Actions’ in the context menu. Select the ‘Batch Create’
action.

A UI should pop up on your screen. Select the number of tasks you’d like to create per shot and click ‘Submit’

[image: _images/batch_create.png]
Once you hit submit, a second UI should pop up asking for further options.

[image: _images/batch_create_seq.png]
Add a sequence name.
In the ‘Expression’ box under shots, the ‘#’ denotes the padding. So ‘####’ would mean shots will be
created as 0010, 0020.

In the Incremental box, 10-20:10 indicates shots would be create from 10 till 20 with an increment of 10.
So, in this case only 2 shots will be created, 0010 and 0020.

Adding a sequence prefix will name the shots 001_0010 and 001_0020. By default, this is set to ‘Yes’

Now select the tasks you want to create for all the shots. You can add a bid for each task as well.

Finally, the UI will ask you if you would like to create another sequence. If you are done creating shots
you can select ‘No’ and the UI will go away. If you would like to create another sequence then select ‘Yes’,
hit submit and repeat the above process.


Note

Creating a task in ftrack will create the corresponding folder structure on disk. If there



are template files defined for the task, then they may be copied for the shots. Currenly, the compositing
and rotoscoping tasks have template files.

In this workflow you have to copy the media to the image folder. The media folder is located at
<project_dir>/shots/<shot_dir>/img/plates/







          

      

      

    

  

    
      
          
            
  
Internal Review System


Artist Workflow


Submitting to Dailies

If for any reason, the post render script cannot upload the media to Ftrack, the artist can do so through
the Ftrack web browser. Click on the task, then click on the actions menu and select the “Upload Media”
action.

[image: _images/review.gif]
Once the action UI opens, copy paste your file into the text box and hit submit.

[image: _images/upload-media.gif]
The jobs icon in the top right corner of your browser will give you an update on your job.

[image: _images/upload-update.png]
The action will work for movies and images.


Note

Always upload media to Ftrack using this action if you want your output to be viewed in dailies.








Producer Workflow


Reviewing with Lists

Select a review list from the side bar on the left. Right click on the list and select Launch RV.

[image: _images/internal-review-sidebar.png]
This will launch RV and create a playlist of all the asset versions in the list.




Reviewing without Lists

If no review list exists, you can still review in RV by selecting the individual asset versions.

Navigate to the project sequence and select the ‘Versions’ tab.
Ctrl select the versions you would like to review. Right click on the selected versions and select
‘Play selection in RV’

[image: _images/internal-review-versions.png]
This will launch RV and create a playlist of all the asset versions in the list.









          

      

      

    

  

    
      
          
            
  
Client Review System

Loco VFX uses a local installation of ftrack. As a result, clients do not have access to
the media uploaded by the artists. This makes client reviews tedious and gathering notes and
feedback difficult. A solution such as CineSync is ideal, but comes at a price.

The Ftrack cloud server (a remote ftrack installation) supports client reviews natively. It allows clients
to view media and give notes in an easy and secure environment.

Our client review system tries to leverage the benefits of the ftrack cloud server while keeping costs at a
minimum.


Setup


	A single user ftrack cloud account

	An action running locally that syncs the local client review session with the remote cloud account

	An action running locally that syncs the feedback from the remote cloud account to the local ftrack session.






Syncing the Client Review Session

You can watch this video [https://www.ftrack.com/portfolio/internal-client-review-ftrack] to learn about how create a client review session in Ftrack.

Once you have created your client review session, click on the session and select ‘Actions’ from the
drop down menu.

[image: _images/client-review-selection.png]
When you click on Actions, these actions should pop up on your screen.

[image: _images/client-review-actions.png]
Select the ‘Review Sync’ action. This will start the sync.

The progress of the sync can be seen by clicking the ‘jobs’ icon in the top right corner of your Ftrack
browser.

[image: _images/client-review-update.png]
[image: _images/client-review-complete.png]
Once the sync is completed, go over to the ftrack cloud account [https://locovfx.ftrackapp.com]. Sign in and navigate to your project.
A client review session that mirrors your local client session will be available to you.

You can now add clients as collaborators and send invites for the client review. Once again, you may refer
to the video mentioned above on how to do this.




Syncing the Client Feedback

The client feedback sync is a two step process.


	Watch this video [https://www.ftrack.com/portfolio/internal-client-review-ftrack] to learn transfer feedback from the client session.



The client review session as seen by the clients is a separate entity from the Ftrack account. As a result,
any information that the client adds to this review session must be transferred back to the Ftrack account.


Note

The feedback is transfered to our cloud Ftrack account. Proceed with step 2 to transfer
and update our local Ftrack server.



2. In the local Ftrack session, navigate to the review session once again. Select ‘Actions’ from the drop
down menu.

[image: _images/client-review-selection.png]
Select ‘Feedback Sync’ Action from the actions that pop up on your screen.

[image: _images/client-review-actions.png]
This will sync the feedback from the cloud Ftrack account to the local Ftrack server. It will update
the status of the tasks to either ‘Review Changes’ or ‘Approved’ depending on the feedback. Asset Versions
will be also be updated with the client’s notes.




Client Session Tutorial

You can refer to this page for a client side review session tutorial.







          

      

      

    

  

    
      
          
            
  
Modeling Pipeline


Note

Before you start anything, make sure that ftrack-connect is running.




Artist Workflow


Open a scene file

Once an artist is assigned a modeling task, the artist must navigate to the Ftrack task
and open the Maya scene file from the actions menu.

[image: _images/comp.gif]
When the application launches, the artist timer will start in Ftrack. This tracks the time the
artist spends on the task.

[image: _images/ftrack-timer.png]
The timer stops when the application is closed.




Modeling File Location

When the artist starts maya from ftrack, the corresponding asset’s model file will be launched.
The file should be called <assetName_version>.mb and will be located at:

/data/production/<show>/assets/<assetType>/<assetName>/modeling/maya/





For example the location of a model file for asset ‘boy’ of type ‘character for project ‘test’ will be:

/data/production/test/assets/character/boy/modeling/maya/boy_v01.mb








Creating a Turntable

A turntable render is a great way to view the model along with it’s shading.

To create a turntable, first select a mesh by clicking on the asset in the viewport.
Then click the turntable button in the LVFX_Modeling shelf.

[image: _images/turntable.png]
This will create a camera and a 3 point light setup around the asset.




Naming Conventions

The asset must be grouped under a parent group. The parent group must have ‘_grp’ in it’s name.
This group must have a child group with ‘_geo’ in it’s name. The ‘geo’ group must contain the meshes that
constitute the asset.

[image: _images/asset_outliner.png]
It is important to name the model and it’s parts correctly as these names will travel through the pipeline.




Publishing

When a model has to be made available to other departments, the artist must run a ‘Publish’
This can be done by selecting ‘Publish’ under the File menu in Maya.

[image: _images/publish.png]
The publish involves running a slew of validations. These validations include checking if the scene was
opened via Ftrack, checking the file and model naming conventions, checking for locked normals, file
history and so on. If a scene passes the validation checks, then the publish is run.

[image: _images/pyblish-gui.png]
[image: _images/pyblish-buttons.png]
Press the ‘Play’ button shown above to run the validation and publish. If the validation fails,
check the log and fix the scene. Then press the ‘refresh’ button and re-run the validation and publish.

The model in the scene is exported to a publish folder and renamed:

/data/production/<show>/assets/<assetType>/<assetName>/modeling/publish/assetName_ref.mb





This scene is now available to the downstream departments to use in their scenes.
The corresponding ftrack task is updated with the publish data.









          

      

      

    

  

    
      
          
            
  
Rigging Pipeline


Note

Before you start anything, make sure that ftrack-connect is running.




Artist Workflow


Open a scene file

Once an artist is assigned a modeling task, the artist must navigate to the Ftrack task
and open the Maya scene file from the actions menu.

[image: _images/comp.gif]
When the application launches, the artist timer will start in Ftrack. This tracks the time the
artist spends on the task.

[image: _images/ftrack-timer.png]
The timer stops when the application is closed.




Rigging File Location

When the artist starts maya from ftrack, the corresponding asset’s model file will be launched.
The file should be called <assetName_version>.mb and will be located at:

/data/production/<show>/assets/<assetType>/<assetName>/rigging/





For example the location of a rig file for asset ‘boy’ of type ‘character for project ‘test’ will be:

/data/production/test/assets/character/boy/rigging/boy_v01.mb








File Setup

A rigging artist must import the publish modeling reference file into their scene.
The latest published modeling reference is located at:

/data/production/<show>/assets/<assetType>/<assetName>/modeling/publish/assetName_ref.mb








Naming Conventions

The rig must be grouped under a parent group. The parent group must have ‘_grp’ in it’s name.
This group must have 2 child groups: one with ‘_geo’ in it’s name and another with ‘_rig’ in its name.
The ‘geo’ group contains the reference model. The ‘rig’ group contains the asset rig.

[image: _images/rig_outliner.png]
It is important to name the model and it’s parts correctly as these names will travel through the pipeline.




Publishing

When a rig has to be made available to other departments, the artist must run a ‘Publish’
This can be done by selecting ‘Publish’ under the File menu in Maya.

[image: _images/publish.png]
The publish involves running validation tests that check if the scene was opened via Ftrack,
if the file and rig naming conventions are correct and so on.
If a scene passes the validation checks, then the publish is run.

[image: _images/pyblish-rig-gui.png]
[image: _images/pyblish-buttons.png]
Press the ‘Play’ button shown above to run the validation and publish. If the validation fails,
check the log and fix the scene. Then press the ‘refresh’ button and re-run the validation and publish.

The model in the scene is exported to a publish folder and renamed:

/data/production/<show>/assets/<assetType>/<assetName>/rigging/publish/assetName_rig.mb





This scene is now available to the downstream departments to use in their scenes.
The corresponding ftrack task is updated with the publish data.









          

      

      

    

  

    
      
          
            
  
Layout Pipeline


Note

Before you start anything, make sure that ftrack-connect is running.




Artist Workflow


Open a scene file

Once an artist is assigned a layout task, the artist must navigate to the Ftrack task
and open the Maya scene file from the actions menu.

[image: _images/comp.gif]
When the application launches, the artist timer will start in Ftrack. This tracks the time the
artist spends on the task.

[image: _images/ftrack-timer.png]
The timer stops when the application is closed.




Layout File Location

When the artist starts maya from ftrack, the corresponding task’s scene file will be launched.
The file will be located at:

/data/production/<show>/shots/<sq>/<shot>/scene/layout/<shot>_<version>.mb





For example the location of a layout file for shot ‘001_0010’ in sequence ‘001’ for project ‘test’ will be:

/data/production/test/shots/001/001_0010/scene/layout/001_0010_v01.mb








Scene Setup

Open the scene file from ftrack. Click on the LVFX layout shelf. There are 2 tools in LVFX_Layout shelf.

[image: _images/layout-shelf.png]

	The camera tool - Creates a film camera in your scene called ‘renderCam’. This camera has extra attributes
to add an overlay to your viewport when you look through the renderCam. The overlay can be used for framing
and scene composition.

[image: _images/camera-attr.png]
[image: _images/viewport-layout.png]


	The reference tool - The second tool in the layout shelf is the reference editor. The layout artist must
refernence the enviroment and character elements through this GUI only.The assets are referenced in with
the correct namespace which are used during the publish process.
.. note:: All set dressing elements (those elements that will not be animated) must be referenced in as environment
elements and all elements that will be animated must be referenced in as character.

[image: _images/layout-ref.png]







Scene Publish

When the layout scene has to be made available to other departments, the artist must run a ‘Publish’
This can be done by selecting ‘Publish’ under the File menu in Maya.

[image: _images/publish.png]
The publish involves running validation tests that check if the scene was opened via Ftrack,
if the file naming conventions are correct, if a valid renderCam exists and so on.
If a scene passes the validation checks, then the publish is run.

[image: _images/layout-publish.png]
[image: _images/pyblish-buttons.png]
Press the ‘Play’ button shown above to run the validation and publish. If the validation fails,
check the log and fix the scene. Then press the ‘refresh’ button and re-run the validation and publish.

The layout publish will result in 3 files:


	The renderCam is exported as an alembic file to:

/data/production/<show>/shots/<sq>/<shot>/shotAsset/camera/renderCam.abc







	The environment elements in the scene are exported to a separate env master file located at:

/data/production/<show>/shots/<sq>/<shot>/scene/layout/publish/env.mb







	The character elements in the scene are exported to a separate char file located at:

/data/production/<show>/shots/<sq>/<shot>/scene/layout/publish/<version>/char.mb









In addition, the artist may choose to run a maya playblast for the scene.

The published files are now available to the downstream departments to use in their scenes.
The corresponding ftrack task is updated with the published data as well as the playblast movie, if one
was created.









          

      

      

    

  

    
      
          
            
  
Animation Pipeline


Note

Before you start anything, make sure that ftrack-connect is running.




Artist Workflow


Open a scene file

Once an artist is assigned an animation task, the artist must navigate to the Ftrack task
and open the Maya scene file from the actions menu.

[image: _images/comp.gif]
When the application launches, the artist timer will start in Ftrack. This tracks the time the
artist spends on the task.

[image: _images/ftrack-timer.png]
The timer stops when the application is closed.




Animation File Location

When the artist starts maya from ftrack, the corresponding task’s scene file will be launched.
The file will be located at:

/data/production/<show>/shots/<sq>/<shot>/scene/animation/<shot>_<version>.mb





For example the location of a animation file for shot ‘001_0010’ in sequence ‘001’ for project ‘test’ will be:

/data/production/test/shots/001/001_0010/scene/animation/001_0010_v01.mb








Scene Setup

If a version 01 of the animation file does not exist, the artist can create one by running the “Get Latest
Publish” action. This action can be found by clicking on the animation/previz task and selecting the Actions
menu

[image: _images/get-latest-publish.png]
This action creates an animation file based on the latest layout publish. It copies the character file
imported by layout, references in the master environment file and also references in the camera alembic file
published by layout.




Scene Update

When artist opens the file associated with the task from Ftrack, it opens the file that is mentioned in the
task’s metadata. This information can be found under the ‘Info’ tab of the task.

[image: _images/task-meta.png]
If this filename does not correspond to your latest working version, simply click on the action menu and
select “Update to latest”. This action will update the metadata to the latest version of the file. You can
then proceed to open the application via Ftrack.

[image: _images/update-to-latest.png]



Animation Publish

When the animation has to be made available to other departments, the artist must run a ‘Publish’
This can be done by selecting ‘Publish’ under the File menu in Maya.

[image: _images/publish.png]
The publish involves running validation tests that check if the scene was opened via Ftrack,
if the file naming conventions are correct, if the character hierarchies are correct and so on.
If a scene passes the validation checks, then the publish is run.

[image: _images/animation-publish.png]
[image: _images/pyblish-buttons.png]
Press the ‘Play’ button shown above to run the validation and publish. If the validation fails,
check the log and fix the scene. Then press the ‘refresh’ button and re-run the validation and publish.

The animation publish


	Exports an alembic file for each character in the scene. The alembic file is exported to:

/data/production/<show>/shots/<sq>/<shot>/shotAsset/<assetName>/<version>/<assetName>.abc







	Creates a playblast. The playblast is saved to:

/data/production/<show>/shots/<sq>/<shot>/scene/animation/playblast/<shot>_<version>.mov









The playblast is uploaded to ftrack for review. The task metadata is also updated with the publish
information.









          

      

      

    

  

    
      
          
            
  
Lighting Pipeline


Note

Before you start anything, make sure that ftrack-connect is running.




Artist Workflow


Open a scene file

Once an artist is assigned an lighting task, the artist must navigate to the Ftrack task
and open the Maya scene file from the actions menu.

[image: _images/comp.gif]
When the application launches, the artist timer will start in Ftrack. This tracks the time the
artist spends on the task.

[image: _images/ftrack-timer.png]
The timer stops when the application is closed.




Lighting File Location

When the artist starts maya from ftrack, the corresponding task’s scene file will be launched.
The file will be located at:

/data/production/<show>/shots/<sq>/<shot>/scene/lighting/<shot>_<version>.mb





For example the location of a animation file for shot ‘001_0010’ in sequence ‘001’ for project ‘test’ will be:

/data/production/test/shots/001/001_0010/scene/lighting/001_0010_v01.mb








Scene Setup

If a version 01 of the lighting file does not exist, the artist can create one by running the “Get Latest
Publish” action. This action can be found by clicking on the lighting task and selecting the Actions
menu

[image: _images/get-latest-publish.png]
This action creates a lighting file based on the latest animation publish. It references in the reference
model into the lighting scene file and merges it with animation alembic cache for each character published
by animation. It also references in the latest camera published by layout.




Scene Update

When artist opens the file associated with the task from Ftrack, it opens the file that is mentioned in the
task’s metadata. This information can be found under the ‘Info’ tab of the task.

[image: _images/task-meta.png]
If this filename does not correspond to your latest working version, simply click on the action menu and
select “Update to latest”. This action will update the metadata to the latest version of the file. You can
then proceed to open the application via Ftrack.

[image: _images/update-to-latest.png]



Sumbitting Renders

A lighting artist can render their scenes on the farm by following the steps mentioned in here.









          

      

      

    

  

    
      
          
            
  
Compositing Pipeline


Note

Before you start anything, make sure that ftrack-connect is running.




Artist Workflow


Open a scene file

Once an artist is assigned a compositing task, the artist must navigate to the Ftrack task
and open the Nuke scene file from the actions menu.

[image: _images/comp.gif]
When the application launches, the artist timer will start in Ftrack. This tracks the time the
artist spends on the task.

[image: _images/ftrack-timer.png]
The timer stops when the application is closed.




Nuke File Location

When the artist starts nuke from ftrack, the corresponding shot’s nuke script will be launched.
The file should be called <shotname_version>.nk and will be located at:

/data/production/<show>/shots/<sq>/<shot>/scene/compositing/





For example the location of a nuke file for shot ‘001_0010’ in sequence ‘001’ for project ‘test’ will be:

/data/production/test/shots/001/001_0010/scene/compositing/001_0010_v01.nk








Nuke File Structure

A nuke file for a brand new shot must have the following nodes.

[image: _images/nuke-template.png]

	The read node



[image: _images/nuke-read.png]
The python script in the file attribute calculates the correct path of the read image.
Usually this will be:

/data/production/<show>/shots/<sq>/<shot>/img/plates/<filename>.<frame>.dpx






	The slate



The slate adds shot and user information to the movie.

[image: _images/nuke-slate-eg.png]
A bunch of python scripts in the slate node pull in the shot and artist information from ftrack
and populate the slate. You shouldn’t have to touch any of these scripts, just make sure the slate node
is connected to your write_mov node and it should work for you.

[image: _images/nuke-slate.png]

	The write nodes



[image: _images/nuke-write.png]
There will be 2 write nodes in the nuke script.

1. The Write_dpx node will output dpx images. These are normally used during final delivery.
The python script in the file attribute calculates the correct path for your output images.
Usually this should point to:

/data/production/<show>/shots/<sq>/<shot>/img/comps/<version>/img/<filename>.<frame>.dpx





2. The Write_mov node will output a movie. The movie is used for internal reviews.
The python script in the file attribute calculates the correct path for your output movie.
Usually this should point to:

/data/production/<show>/shots/<sq>/<shot>/img/comps/<version>/mov/<filename>.mov






Note

Make sure the codec is set to Avid DNxHD Codec, so that the shot can viewed correctly
for dailies.






Saving a New Version

To save a new version, simply click on “LVFX-Save New Version” option under the File menu or hit
Alt+Shift+S

[image: _images/nuke-save.png]
This will save a new version of the file using the correct naming convention.




Submitting To Dailies

The Write_mov node has a tab called Dailies with a ‘Submit to Dailies’ button.

[image: _images/nuke-dailies.png]
When an artist wishes to submit the movie to dailies, they can click this button.
This will render the shot and then encode and upload the movie to Ftrack. This process can take a while,
so be patient!




Submit To Render Farm

Open the Shot Submit plugin by selecting it from the Loco VFX menu in the nuke menu bar.

[image: _images/nuke-menu.png]
This should open the Shot Submit window.

[image: _images/nuke-submit.png]
The plugin should come pre-populated with your current nuke file. You can select the write node that
you want to render from the drop down menu. Specify a frame range and frame step if you want, by default
it will render the entire frame range with a frame step 1.

Don’t change anything under the job set section. The default options will work for you.


Note

Make sure the client pool is set to “Linux Farm” and Frame Spilit Mode is set to “No Splitting”.
(The default options) This will ensure your job will be run on a single linux farm machine and
your job does not consume all or run out of nuke render licenses.



If you render a movie on the farm, the movie will automatically be encoded and submitted to Ftrack for
dailies post render.




Starting and Stopping the Ftrack Timer.

As mentioned above, the artist timer for the task starts when the application is launched.
Sometimes, an artist may want to leave their nuke session open overnight (if a render is on going) but
may not want to keep their timer running. Similarly, an artist may want to restart the timer without
having to restart the application.

For instances such as these, the artist can use the ‘Start Ftrack Timer’ and ‘Stop Ftrack Timer’ scripts
located in the ‘Loco VFX’ menu in the nuke menu bar.

[image: _images/nuke-start-stop-timer.png]








          

      

      

    

  

    
      
          
            
  
Rotoscoping Pipeline


Note

Before you start anything, make sure that ftrack-connect is running.




Artist Workflow


Open a scene file

Once an artist is assigned a rotoscoping task, the artist must navigate to the Ftrack task
and open the Nuke scene file from the actions menu.

[image: _images/comp.gif]
When the application launches, the artist timer will start in Ftrack. This tracks the time the
artist spends on the task.

[image: _images/ftrack-timer.png]
The timer stops when the application is closed.




Nuke File Location

When the artist starts nuke from ftrack, the corresponding shot’s nuke script will be launched.
The file should be called <shotname_version>.nk and will be located at:

/data/production/<show>/shots/<sq>/<shot>/scene/rotoscoping/





For example the location of a nuke file for shot ‘001_0010’ in sequence ‘001’ for project ‘test’ will be:

/data/production/test/shots/001/001_0010/scene/rotoscoping/001_0010_v01.nk








Nuke File Structure

A nuke file for a brand new shot must have the following nodes.

[image: _images/nuke-roto-template.png]

	The read node



[image: _images/nuke-roto-read.png]
The python script in the file attribute calculates the correct path of the proxy image.
Usually this will be:

/data/production/<show>/shots/<sq>/<shot>/img/plates/proxy/<filename>.<frame>.jpeg






	The slate



The slate adds shot and user information to the movie.

[image: _images/nuke-slate-eg.png]
A bunch of python scripts in the slate node pull in the shot and artist information from ftrack
and populate the slate. You shouldn’t have to touch any of these scripts, just make sure the slate node
is connected to your write_mov node and it should work for you.

[image: _images/nuke-slate.png]

	The write node



[image: _images/nuke-write.png]
The Write_mov node will output a movie for internal reviews.
The python script in the file attribute calculates the correct path for your output movie.
Usually this should point to:

/data/production/<show>/shots/<sq>/<shot>/img/roto/<version>/mov/<filename>.mov






Note

Make sure the codec is set to Avid DNxHD Codec, so that the shot can viewed correctly
for dailies.






Saving a New Version

To save a new version, simply click on “LVFX-Save New Version” option under the File menu or hit
Alt+Shift+S

[image: _images/nuke-save.png]
This will save a new version of the file using the correct naming convention.




Submitting To Dailies

The Write_mov node has a tab called Dailies with a ‘Submit to Dailies’ button.

[image: _images/nuke-dailies.png]
When an artist wishes to submit the movie to dailies, they can click this button.
This will render the shot and then encode and upload the movie to Ftrack. This process can take a while,
so be patient!




Starting and Stopping the Ftrack Timer.

As mentioned above, the artist timer for the task starts when the application is launched.
Sometimes, an artist may want to leave their nuke session open overnight (if a render is on going) but
may not want to keep their timer running. Similarly, an artist may want to restart the timer without
having to restart the application.

For instances such as these, the artist can use the ‘Start Ftrack Timer’ and ‘Stop Ftrack Timer’ scripts
located in the ‘Loco VFX’ menu in the nuke menu bar.

[image: _images/nuke-start-stop-timer.png]








          

      

      

    

  

    
      
          
            
  
Render Management


Submitting Renders to the Farm


From Maya

The shot_submit tool in Maya lets you submit VRay scene exports and VRay scenes for render on the farm.
Select ShotSubmit in the LocoVFX menu. The Shot Submit GUI will open in the side tool bar.

[image: _images/ss_menu_maya.png]
VRay Exporter

[image: _images/vray_exporter.png]
This dialog submits a maya file on the farm to be exported as a vray scene file.

Let’s go over some of the parameters:


	Maya Filename: Full path of the maya file to be exported

	Render Layer: Select render layers. A new vray scene file is exported per render layer.
If no render layer is selected, then by default the ‘masterLayer’ is exported.

	Camera: Select the correct render camera from the drop down menu.

	VRscene Filename: The name of the output vray scene file.

	Separate Frames: If checked, a vrscene file is exported per frame.

	Project Dir: Output directory of the VRay scene file.



For example:

Project Dir = /data/production/ftrack_test/shots/REEL3/REEL3_sh010/scene/lighting/
VRscene filename = REEL3_sh010_lighting
Render Layers = beauty, shadow
Output VRScene Files = /data/production/ftrack_test/shots/REEL3/REEL3_sh010/scene/lighting/beauty/REEL3_sh010_lighting.vrscene
and /data/production/ftrack_test/shots/REEL3/REEL3_sh010/scene/lighting/shadow/REEL3_sh010_lighting.vrscene






	Frame Split Mode: This must always be set to “No splitting”

	Chunk Size: This is always 0 as frame splitting is disabled.

	Client Pool: By default this is set to vray. You can also select ‘Linux Farm’ to render on any farm machine.

	Slack User: A message will be sent to this slack user when a render completes or fails.
By default set to #render-updates channel. Can be replaced by the slack username.



VRay Standalone

Changing the Renderer option in the Shot Submit UI to VRay Standalone will change the render options.

[image: _images/vray_standalone.png]
This dialog submits an exported VRay scene file on the farm for render.

Let’s go over some of the parameters:


	VRay Filename: The name of the VRay scene file.



For example:

For single VRScene File:
VRay Filename = /data/production/ftrack_test/shots/REEL3/REEL3_sh010/scene/lighting/beauty/REEL3_sh010_lighting.vrscene
For per frame VRScene files named REEL3_sh010_lighting.0001.vrscene, REEL3_sh010_lighting.0002.vrscene etc
VRay Filename = /data/production/ftrack_test/shots/REEL3/REEL3_sh010/scene/lighting/beauty/REEL3_sh010_lighting.#.vrscene






	Multiple VRScene Files: This is checked if VRScene files are exported per frame. If this is checked,
the name of the VRScene must be formatted as shown in the example above.

	Output File: Name of the output file. eg. REEL3_sh010_beauty_v01.#.exr (The # is replaced by frame numbers
on the farm)

	Output Dir: Output directory where the rendered images should be written.

	Upload to Ftrack: If checked, the output images are converted to a movie and uploaded to Ftrack.

	Frame Split Mode: Select “Split into X frames per chunk” so that the images are rendered on multiple
render clients.

	Chunk Size: Default is 5. This means 5 frames will rendered per render client.

	Dependent On: If this job is dependent on another job, eg. A VRay Export job then type in the job ID
of the vray exporter job here. The vray render will now run only after the vray export is complete.

	Progressive Step: In case you do not want the frames to render in a linear manner.



For example:

Progressive Step = 4, Total Frames = 10 and chunk size = 3
Chunk 1 will render frames 1, 5, 9
Chunk 2 will render frames 2, 6, 10
Chunk 3 will render frames 3, 7
Chunk 4 will render frames 4, 8








From command line

If you do not want to open Maya, you can also submit jobs for vray scene export and
vray scene renders from the commandline.

vray_export:

usage: vray_export.py [-h] -scene SCENE [-proj PROJ] -start START -end END
                  [-step STEP] [-cam CAM] [-rl RL] -ex EX [-sep [SEP]]
                  [-user USER] [-group GROUP] [-priority PRIORITY]

Submits a VR Export Job to HQueue.

optional arguments:
  -h, --help          show this help message and exit
  -scene SCENE        Input Maya scene file
  -proj PROJ          VRScene output folder. Defaults to <maya scene
                      dir>/vrscene
  -start START        Start frame
  -end END            End frame
  -step STEP          Step
  -cam CAM            Camera to be rendered
  -rl RL              Render Layers to be rendered. Comma separated list
  -ex EX              Exported VRscene file name
  -sep [SEP]          Export separate vrscene files per frame.
  -user USER          Send post render to slack user
  -group GROUP        HQueue client group name
  -priority PRIORITY  HQueue render priority





vrscene_submit:

Usage:

vrscene_submit -v <vrscene> -i <imgFile> -f <firstFrame> -l <lastFrame> -s <step> -c <chunk>
               -m -g <group> -p <priority> -u <username> -r -d <jobID> -o <prog>
Submits vrscene file for render to hqueue

vrscene = Full filepath. When submitting multiple vrscene files, replace frame with #
eg. /data/production/ftrack_test/shots/REEL3/REEL3_sh010/scene/lighting/test.#.vrscene

imgFile = Full path to output img file
first = first Frame
last = last Frame
step = frame step. Default = 1
chunk = chunk size. Default = 5
multiple = multiple VR scene files. Default = False
group = name of group to submit to
priority = priority of job. 0 is lowest. Default is 0
slackuser = slack username. Default=#render-updates channel
review = Create movie and upload to ftrack. Default = False
dependent = Job ID of the dependent job
progressive = Progressive Step

 ---Multiple VRScene File Example---
vrscene_submit -v /data/production/ftrack_test/shots/REEL3/REEL3_sh010/scene/lighting/vrscene/stagBeetleTest_#.vrscene
               -i /data/production/ftrack_test/shots/REEL3/REEL3_sh010/scene/lighting/vrscene/renders/stagBeetleTest.#.exr
               -f 1 -l 15 -s 4 -c 5 -r -m

 ---Single VRScene File Example---
vrscene_submit -v /data/production/ftrack_test/shots/REEL3/REEL3_sh010/scene/lighting/vrscene/stagBeetleTest.vrscene
               -i /data/production/ftrack_test/shots/REEL3/REEL3_sh010/scene/lighting/vrscene/renders/stagBeetleTest.#.exr
               -f 1 -l 15 -s 1 -c 5 -r








From Nuke

Nuke script files can be submitted for render on the farm. Open the Shot Submit UI by clicking on
‘Shot Submit’ under the LocoVFX menu.

[image: _images/ss_menu_nuke.png]
[image: _images/nuke_shotsubmit.png]
Let’s go over some of the parameters:


	Filename: Full filepath of the nuke script file.

	Frame Range: Enter the frame range eg. 1-10.
Leaving this black will render the entire.

	Write Node: Select a write node from the drop down menu








Monitoring the Render Farm

We use Houdini’s HQueue as our render farm manager.
You can access the HQueue Server page at: http://192.168.0.153:5000


Monitoring with Slack

When a render completes, a message is sent on slack by default to #render-updates channel.
The message includes the jobID of the completed job and the success/failure status.

If the job has failed, you can use slack to retrieve the failed jobs as well as the output log.
This is especially useful if you are at home and do not have access to the Hqueue page.

To query failed jobs, send a direct message to @renderbot on slack.
The slack account is: https://locovfx.slack.com

Type in the following command:

@renderbot: getFailed <jobId>
where jobId: Parent job ID





In response you should get a list of failed jobs child jobs

You can now get an output log of one of the child jobs to understand why the render failed.

Type the following command:

@renderbot: getLog <jobId>





This will return the output log for that jobID.









          

      

      

    

  

    
      
          
            
  
Setting up on Linux


Setting up a new CentOS workstation

Documentation can be found at: /data/production/pipeline/linux/common/docs/workstation_setup.pdf




Setting up a new ftrack server

Documentation can be found at: /data/production/pipeline/linux/common/docs/ftrack_server_setup.pdf




Setting up a ftrack content server

Documentation can be found at /data/production/pipeline/linux/common/docs/ftrack_content_server_setup.pdf


Note

This is not being used, but just instructions on how to set it up if we choose to use
use it in the future






Setting up a subversion server

Documentation can be found at /data/production/pipeline/linux/common/docs/subversion_setup.pdf


Note

This is not being used, but just instructions on how to set it up if we choose to use
use it in the future









          

      

      

    

  

    
      
          
            
  
Ftrack Event Server

This ftrack event server is hosted on the workstation 192.168.0.153. It runs continuously and
monitors ftrack for certain events or actions. Certain events trigger certain scripts to run automatically
in the background. For example, creating folders on disk when a task is created in Ftrack.

The event server also hosts actions, which require the user to actively choose an action from the action
menu in ftrack.


What scripts are triggered by the event server?


	
	Add version to list

	If an asset version’s status is updated to “Pending Internal Review”, then add it to the Dailies Review
List. If the time of status update is before 10 am, then add it to the list of the same date, else
add it to the next day’s review list.





	
	Create Project folder

	When a new project of type “VFX Schema” is created on Ftrack, a project folder is created on disk.
The project folder follows the LocoVFX project template structure. More details found here .





	
	Assign task status

	This event sets the task status based on the asset version. So if a particular asset version’s status
is set to ‘Approved’, then the status of the task of that version is also set to ‘Approved’.





	
	Status Handler

	This event is only triggered for animation or lighting tasks. If an animation task’s status is set
to ‘Ready for Lighting’ the assigned user of the Lighting task is sent a message on slack. Similarly,
if a lighting task’s status is set to ‘Ready for Comp’, the assigned user of the compositing task
is sent a message on slack.





	
	Create Task Folder

	This event creates a task folder on disk (along with the shot structure, if a shot structure does
not exist). It also copies the template file of that task into the task folder and names it
appropriately





	
	Set task thumbnail

	If the status of a task is set to ‘Cut’ or ‘On Hold’, set the appropriate thumbnail icon for that task.










What actions are hosted on the event server?


	
	Batch Create

	Batch create shots in Ftrack. This action is available for at the project, sequence and shot level.







	
	Clear Job Queue

	Clears all pending user jobs in the ftrack job queue. This action is available for all ftrack elements.







	
	Client Review Sync

	Syncs a client review session with the Ftrack cloud account. This action is only available on the
client review session.







	
	Client Feedback Sync

	Syncs the feedback from the Ftrack Cloud client review session with the local session. This action
is only available on the client review session.







	
	Upload Media

	Provides a UI to upload media for dailies review. This action is only available for ftrack tasks.







	
	Update RV Component

	This action is only available on an asset version. Adds a ‘movie’ component to the asset version,
so that the media is playable in RV. If an asset version is missing this component, the media will
not play in RV.

[image: _images/rv-component.png]











Who runs the event server?

The event server is nothing but a python script located at /data/production/pipeline/linux/ftrack-events/server.py.
As long as this python script is running, the ftrack events and actions will be monitored. So we need
a process that will continuously run this event server script and monitor and log it’s behaviour.

A supervisor daemon is a process that does this for us. The details of the script are included in the
supervisord config file located at /etc/supervisord.conf

We start the supervisord by running:

service supervisord start





This is run in the terminal as a “root” user.

Similarly, we can stop the supervisord by running:

service supervisord stop





The supervisor daemon automatically starts itself when the workstation boots up. The logs of the ftrack
event server are written to /tmp/ftrack_event_server.log







          

      

      

    

  

    
      
          
            
  
Slack Messaging Setup


When are slack messages sent?


	renderbot sends messages to groups or users on slack when

	
	There is a new publish

	If a task status is changed to “Update to Comp” or “Update to Lighting” in ftrack.










How can I ensure my channel receives messages?


	In order for the messaging to work, we need to make sure

	
	
	renderbot is part of the slack group

	type /invite @renderbot in the slack channel to make renderbot part of that group







	Add the slack channel or user to the config file.
The config file is located at /data/production/pipeline/linux/common/config/slack_ftrack_users.json
The file contains a one to one correspondence between the ftrack project name or ftrack username
and the slack channel or username.

Example:

{
#Ftrack username : Slack username
"Natasha":"@natasha",
"Derik":"@derik",
"Jeanelize":"@jeaneliz",
"JC":"@jc",
"Will":"@will",
"David": "@davetheron",
"Gina":"@gina_gibson",
"Dominique":"@dominique",
"George":"@gwebster",
"Jason":"@jason",
"Bradlee":"@hyro-chan",
"vf_alone":"#alone",
"sep_dsl":"#dsl",
#Ftrack Project: Slack channel name
"osg_szm":"#sizematters",
"rnd_pipeline":"#test",
"tutorials":"tutorials"
}



















          

      

      

    

  

    
      
          
            
  
File System Backups

Backing up work to tapes is a 3 step process.


Note

All shell scripts and commands described below must be run on the server 192.168.0.208 as root




1. Preparing the file lists

The LTO-4 tapes we use are 800GB in size. So we must first run a shell script to create file lists
that divide the project that is to be archived into chunks of 800 GB.

Open a terminal and run the following commands:

# sudo as root user
[server@server ~]$ su
Password:
# cd to the backup folder where the scripts are located
[root@server ~]$ cd /opt/backup/
# list the files and directories
[root@server backup]$ ls -l
# This is an example output of the command
total 32
-rw-r--r-- 1 root root 1762 Dec 14  2015 file_chunk.sh
-rwxr-xr-x 1 root root 1454 Jan 25 09:40 post-backup.sh
-rw-r--r-- 1 root root  176 Dec  4  2015 post_chunk.sh
-rwxr-xr-x 1 root root 1718 Sep  2 09:45 pre-backup2.sh
-rwxr-xr-x 1 root root  771 Dec 15  2015 pre-backup-original.sh
-rwxr-xr-x 1 root root 3038 Jan  8  2016 pre-backup.sh
-rw-r--r-- 1 root root 1465 Mar  1  2016 prep_files.sh
drwxr-xr-x 2 root root 4096 Feb  9 22:57 tmpfiles
# if tmpfiles folder exists as shown above, delete all files within it.
[root@server backup]$ rm tmpfiles/*
# now run the command to create the file list.
# prep_files.sh is the script. It should be followed by path to all projects that need
# to be archived. For example:
[root@server backup]$ sh prep_files.sh /data/XFS1/ef_coiled/ /data/XFS1/imp_roots/ /data/XFS1/imp_tut/ /data/XFS1/iso_sob/
# Let this command run, it will take a while





Once the command has finished running, your tmpfiles folder will be filled with files.
Here is an example of what that will look like:

-rw-r--r-- 1 root root 25063593 Jan 16 17:56 backup_filelist_1
-rw-r--r-- 1 root root 25063593 Jan 16 17:56 backup_filelist_2
-rw-r--r-- 1 root root 25063593 Jan 16 17:56 backup_filelist_3
-rw-r--r-- 1 root root 10064025 Jan 16 18:55 prep_file





What does this mean? The backup_filelist1/2/3 are a list of files whose total size 790GB. They can be
neatly archived into 3 LTO tapes.

The prep_file is a list of files that are left. Their size will be less than 790GB and will be considered the next
time the prep_files.sh command is run.




2. Backing up data

Now that we have our files organied into chunks, insert the tape into the tape drive.
Go to the web browser and log into the webmin page.

[image: _images/webmin-login.png]
Login Credentials:

Username: root
Password: server





From the side panel select Filesystem Backup

[image: _images/backup-option.png]
Select /data/backup in the ‘Directory to backup’ column

[image: _images/backup.png]
When you select /data/backup, the edit backup page options. Expand the ‘backup options’ section.

The pre-backup script should be /opt/backup/pre-backup2.sh and the post backup script should be
/opt/backup/post-backup.sh

[image: _images/backup-options.png]
What does the pre-backup script do?

The pre-backup script looks at the the lowest numbered backup filelist that we created in step1. So in the
above example it will look at backup_filelist1. It will copy the files listed in backup_filelist1 to the
location /data/backup/

Once the file copy is complete, it will start archiving the files to the tape. When the archiving to tape
is complete, the post-backup script is run.

What does the post-backup script do?

The post-backup script will first verify if all files in /data/backup have been written to the tape. If
successful, it will write a pdf file with a list of all the archived files. This file is written to
/data/backup_logs/<date_of_backup>.pdf

It writes a second file called backup-dirlist in /opt/backup/tmpfiles/ which is a high level view of the
archived folder structure.
The script then deletes files in /data/backup/. It also deletes the backup-filelist that was used for this
archiving. In this case backup-filelist_1. It does this so the next tape can start archiving files in
backup-filelist_2.




3. Finishing up

Now that the tape is successfully archived, we just need to make sure it is labeled correctly and the logs
are stored in a permanent location.

The tapes are labeled as SAS.LVFX.<tape_number> (VOL <number>).
First copy the file list pdf that was created in step 2 to the correct archive folder. The archive folder is
/data/work01/SAS_archive_catalogues

Here is an example:

# Copy the high level folder structure
[root@server backup]$ cp /opt/backup/tmpfiles/backup_dirlist /data/work01/SAS_archive_catalogues/LVFX.SAS.052.VOL3.txt -Lvr
# Copy the pdf file
cp /data/backup_logs/2017012613.pdf /data/work01/SAS_archive_catalogues/LVFX.SAS.052.VOL3.pdf -Lvr






Note

A good naming practice is to create a new tape number for every new project.
A single project spread across multiple tapes can share the same tape number
and have different volume numbers.



Now that your tape is archived successfully, take it out of the tape drive, insert a new tape and repeat
the process from step 2. Continue till all files in /opt/backup/tmpfiles/ are done.




Deleting the project folder

Once the project has been archived, we must delete the project from the production server.


Important

Check to make sure that there are no files in the /opt/backup/tmpfiles/ folder.
If there is a file there called prep_file, check the file to make sure that no files
from the project you are about the delete are in there.



If you are sure if is safe to delete a project, you should use the linux rm command instead of just
pressing ‘delete’ on the folder in the project browser.

Execute the following commands:

[root@server ~]$ cd /data/XFS1/
[root@server XFS1]$ rm -rfI <project>/








Helpful commands

There might be a case as shown above where a prep_file exists in the /opt/backup/tmpfiles folder.
If this file contains files belonging to the project you are archiving, then you cannot delete the project.
So then what do you do?

First, lets run a command to check what is the size of the files that make up this prep_file.

Run the command:

totalsize=0; while IFS='' read -r line || [[ -n "$line" ]];
do filesize=`du -b -s "$line" | cut -f 1`; totalsize=$(($totalsize+$filesize));
done < /opt/backup/tmpfiles/prep_file; echo $totalsize





The output of the command is in bytes. For example, if the output is 788625545511 that is approximately 788GB.
If size of the files is close to 700GB, you can just rename this file to backup_filelist_1 and re-run the
backup after inserting a new tape.

You can rename the file with:

[root@server XFS1]$ mv /opt/backup/tmpfiles/prep_file /opt/backup/tmpfiles/backup_filelist_1





You can now safely delete the project folder on the production drive.

If the size of files in prep_file is too small, eg 100GB, leave the prep-file as it is. The next time you
backup a project, it will take the files in prep_file under consideration when you run the prep_file.sh
command.







          

      

      

    

  

    
      
          
            
  
Syncing Files


Syncing large number of files

Use the file_sync command to sync files between the 2 studios. This command can be used to sync a single
file or a folder containing multiple files.

In order to use the command, first open a terminal by going to Applications -> System Tools -> Terminal

Syncing a single file:

file_sync -file <file_path>
eg. file_sync -file /data/production/osg_szm/assets/character/Giant_Dog/rigging/publish/Giant_Dog_v10.mb





If this command is run in JHB, it will sync the specified file to CPT and vice-versa


Note

The destination can be specified explicitly by the -dest flag.
Example file_sync -file <file_path> -dest CPT or file_sync -file <file_path> -dest JHB.
However, by default -dest is defined by the “STUDIO” environment variable.

This variable is specified in /data/production/pipeline/linux/common/var/env file.
STUDIO=JHB in Loco VFX studio and STUDIO=CPT in Loco Atlantic studio. So, the user can skip
specifying -dest in the command if this STUDIO variable is set correctly.



Syncing a folder with many files and directories:

file_sync -file /data/production/osg_szm/assets/character/Giant_Dog/rigging/





If this command is run in JHB, it will sync the specified folder, along with all files and folders in it
to CPT and vice-versa.

Syncing a folder while excluding certain types of folders or files:

file_sync -file /data/production/osg_szm/assets/character/Giant_Dog/rigging/ -ex incrementalSave,*.mov





This command will sync all files and folders in the specified directory while excluding the incrementalSave
directory and will also exclude any .mov files.

Queueing a file sync:

file_sync -file /data/production/osg_szm/assets/character/Giant_Dog/rigging/ -ex incrementalSave,*.mov -queue





This command will sync queue the above folder for overnight sync.
A file with the sync command is written out to /data/production/tmp_files/ folder.
A cron runs every evening that syncs all the files in this folder. For more information on crons
click here


Note

Further reading: What is this file_sync command, where does it come from?
The file_sync command is an alias for a python script that is located in the pipeline folder.
So when we run file_sync,  we are actually running
python2.7 /data/production/pipeline/linux/scripts/sync_file.py



Once the command is running successfully you will see the progress in your shell.
Example:

sending incremental file list
rigging/
rigging/Giant_Dog_rigging_v21.mb
     777.70M 100%    7.74MB/s    0:01:35 (xfer#1, to-check=18/45)
rigging/Giant_Dog_rigging_v22.mb
     777.71M 100%    9.05MB/s    0:01:21 (xfer#2, to-check=17/45)
rigging/publish/
rigging/publish/giant_dog_rig.mb -> /data/production/osg_szm/assets/character/Giant_Dog/rigging/publish/v21/giant_dog_rig.mb
rigging/publish/v21/
rigging/publish/v21/giant_dog_rig.mb
     281.52M 100%    4.62MB/s    0:00:58 (xfer#3, to-check=0/45)

sent 336.30M bytes  received 89 bytes  1.40M bytes/sec
total size is 11.66G  speedup is 34.66





You can cancel a running command by simply pressing Ctrl+C in the shell.




Syncing small files

When syncing small files between the 2 studios, you can use the ftrack file_sync action.
This is a simplified version of the above command. Here you can sync a file or folder but you cannot
specify which folders or files should be excluded. It is also difficult to cancel the command once it has
started running or see detailed progress like in the above command.

You can however see if the script is running or if it has finished or failied in your ftrack session.

The file-sync action can be found in the ‘Actions’ window of Ftrack

[image: _images/file-sync-icon.png]
In the file-sync menu, copy-paste the path of the file or folder to sync, then select the direction the
file should travel. CPT->JHB or JHB->CPT and hit submit.

[image: _images/file-sync-action.png]
The job queue in ftrack will give an update of the progress of sync.

[image: _images/file-sync-progress.png]






          

      

      

    

  

    
      
          
            
  
Code Structure

This is a quick overview of the structure of pipeline code.


Where is the pipeline code located?

The live pipeline code is located at /data/production/pipeline/linux/
When doing development work, always work locally in your own sandbox. Never work directly in this
folder. Once you are sure of your script, copy it over to the right folder in this location.




How is it structured?

List of directories:

# Top level code directory
/data/production/pipeline/linux/
# The directory 'common' includes fonts, environment variables, common coding modules etc.
/data/production/pipeline/linux/common
# Contains common fonts to be used by everyone
/data/production/pipeline/linux/common/fonts
# Contains config files used by the shot_submit plugin, slack etc.
/data/production/pipeline/linux/common/config
# Contains common icons
/data/production/pipeline/linux/common/icons
# Contains common code. This includes the ftrack API and common python modules used by plugins
eg. coverting media using ffmpeg, submitting to the farm, common GUI modules etc.
/data/production/pipeline/linux/common/packages
# Template files for various tasks
/data/production/pipeline/linux/common/template
# Envionment variables and aliases
/data/production/pipeline/linux/common/var
/data/production/pipeline/linux/common/sourceimages
/data/production/pipeline/linux/common/lighting_assets
# Documentation files
/data/production/pipeline/linux/common/docs
# All maya pluging and scripts
/data/production/pipeline/linux/maya
# Yeti module
/data/production/pipeline/linux/maya/yeti
# Common Maya shelves
/data/production/pipeline/linux/maya/shelves
# Common maya icons
/data/production/pipeline/linux/maya/icons
# Common maya modules like MTOA and OpenVDB MAYA_MODULE_PATH
/data/production/pipeline/linux/maya/modules
# Maya plugins directory MAYA_PLUG_IN_PATH
/data/production/pipeline/linux/maya/plug-ins
# Maya scripts MAYA_SCRIPT_PATH
/data/production/pipeline/linux/maya/scripts
/data/production/pipeline/linux/maya/scripts/mel
/data/production/pipeline/linux/maya/scripts/python
# Ftrack connect application lives here, along with associated files.
# You shouldn't have to touch this folder.
/data/production/pipeline/linux/ftrack-connect-package
# Ftrack connect user plugins. All ftrack plugins developed by us live here.
/data/production/pipeline/linux/ftrack-connect-plugins
/data/production/pipeline/linux/ftrack-connect-plugins/custom_hook
# All custom ftrack events and actions that are monitored by the ftrack event server.
/data/production/pipeline/linux/ftrack-events
/data/production/pipeline/linux/ftrack-events/plugins
# Custom hiero plugins
/data/production/pipeline/linux/hiero
/data/production/pipeline/linux/hiero/Python
/data/production/pipeline/linux/hiero/Python/Startup
# Common nuke plugins and gizmos
/data/production/pipeline/linux/nuke
# For common nuke gizmos
/data/production/pipeline/linux/nuke/gizmos
/data/production/pipeline/linux/nuke/icons
# For nuke plugins only
/data/production/pipeline/linux/nuke/plugins
# Nuke Python scripts
/data/production/pipeline/linux/nuke/scripts
# Pyblish scripts, organized as per department.
/data/production/pipeline/linux/pyblish-plugins
/data/production/pipeline/linux/pyblish-plugins/animation
/data/production/pipeline/linux/pyblish-plugins/layout
/data/production/pipeline/linux/pyblish-plugins/modeling
/data/production/pipeline/linux/pyblish-plugins/rigging
# Commonly used python scripts, independent of a 3D application.
/data/production/pipeline/linux/scripts
# Standalone Tools
/data/production/pipeline/linux/tools
# Linux service scripts
/data/production/pipeline/linux/init.d








What are the global variables?

All the global environment variables are defined in a single env file.
For JHB:

/data/production/pipeline/linux/common/var/env






	For CPT::

	/data/production/pipeline/linux/common/var/env_cpt



These files are sourced in each computers local ~/.bashrc. These variables tell various application
where to find the plugins and scripts. Also sets up the ftrack environment variables.

Contents of this file:

# Set the STUDIO variable to JHB (It's set to CPT in the env_cpt file)
export STUDIO=JHB

# FOUNDRY_ASSET_PLUGIN_PATH and HIERO_PLUGIN_PATH are used by hiero, these allow us to use the
ftrack plugins in hiero.
export FOUNDRY_ASSET_PLUGIN_PATH=/data/production/pipeline/linux/ftrack-connect-package/resource/legacy_plugins/ftrackProvider
export HIERO_PLUGIN_PATH=/data/production/pipeline/linux/ftrack-connect-package/resource/legacy_plugins/ftrackHieroPlugin:/data/production/pipeline/linux/hiero

# Sets the python path to include all the scripts we have written. Also includes the ftrack-api.
export PYTHONPATH=/usr/local/lib/python2.7/site-packages/:/data/production/pipeline/linux/common/packages/loco-api/:/data/production/pipeline/linux/common/packages/ftrack-api-3.3/:/data/production/pipeline/linux/maya/scripts/python:/data/production/pipeline/linux/ftrack-connect-package/resource/legacy_plugins/theFoundry:/data/production/pipeline/linux/ftrack-connect-package/resource/legacy_plugins/theFoundry/assetmgr_hiero:/usr/local/lib/python2.7/site-packages/pyblish/:/usr/local/lib/python2.7/site-packages/pyblish_maya/

# Setting TEMP variable, used by many scripts to write tmp files.
export TEMP=/tmp

# Setting the icons path
export ICONS_PATH=/data/production/pipeline/linux/common/icons/

# Setting the maya module path
export MAYA_MODULE_PATH=/data/production/pipeline/linux/maya/modules

# Setting the maya plug-in path
export MAYA_PLUG_IN_PATH=/data/production/pipeline/linux/maya/plug-ins

# Setting the maya shelf path
export MAYA_SHELF_PATH=/data/production/pipeline/linux/maya/shelves

# Setting the maya scripts path
export MAYA_SCRIPT_PATH=/data/production/pipeline/linux/maya/scripts/mel

# Setting the nuke path
export NUKE_PATH=/data/production/pipeline/linux/nuke:/data/production/pipeline/linux/nuke/StarPro

# Setting the maya icons path
export XBMLANGPATH=/data/production/pipeline/linux/maya/icons

# Used by the shot-submit plugin in nuke and maya
export SHOT_SUBMIT_CONFIG=/data/production/pipeline/linux/common/config/shot_submit_config.json

# Used by ftrack-connect to find the custom actions written by us.
export FTRACK_EVENT_PLUGIN_PATH=/data/production/pipeline/linux/ftrack-connect-plugins/custom_hook

# Used by the optical flares nuke plugin
export OPTICAL_FLARES_PRESET_PATH=/data/share01/install/2d/Nuke/plugs/OpticalFlaresForNuke.1/OpticalFlares2016/OpticalFlaresForNuke9_1.0.8/Textures-And-Presets
export OFX_PLUGIN_PATH=/data/production/pipeline/linux/nuke/plugins/Lenscare_OFX_v1.44/

# Used by Pyblish during publishing in Maya.
export PYBLISHPLUGINPATH=/data/production/pipeline/linux/pyblish-plugins/
export MAYA_PYTHON_PATH=/usr/autodesk/maya2016/lib/python2.7/site-packages/
export PYBLISH_LAYOUT_PATH=/data/production/pipeline/linux/pyblish-plugins/layout
export PYBLISH_MODELING_PATH=/data/production/pipeline/linux/pyblish-plugins/modeling
export PYBLISH_RIGGING_PATH=/data/production/pipeline/linux/pyblish-plugins/rigging
export PYBLISH_ANIMATION_PATH=/data/production/pipeline/linux/pyblish-plugins/animation








What are the global aliases?

The /data/production/pipeline/linux/common/var/vars file contains a list of variables
and aliases common to all.

The file contains:

# Variables for directories. Just so it's easy to get to these directories via the commandline.
export PIPE_DIR=/data/production/pipeline
export VAR_DIR=$PIPE_DIR/common/var
export PACKAGES_DIR=$PIPE_DIR/common/packages
export PIPE_DEV_DIR=$PIPE_DIR/dev
export PIPE_LIVE_DIR=$PIPE_DIR/live
export FTRACK_DEV_DIR=$PIPE_DEV_DIR/ftrack-connect-package/resource
export FTRACK_LIVE_DIR=$PIPE_LIVE_DIR/ftrack-connect-package/resource
export SHOT_SUBMIT_CONFIG=/data/production/pipeline/linux/common/config/shot_submit_config.json
export CONFIG_DIR=/data/production/pipeline/linux/common/config/

# Slack bot token. Used by renderbox and slack API
export SLACK_BOT_TOKEN=xoxb-72401566256-txDVSBf3peXtMnhdpDBnJ1iM

# Defining aliases. Aliases are like short cuts, so instead of typing
"python2.7 <path to script> the user would simply type prores_create or whatever the alias
name is. It helps create a quick short command in place of a long one.
alias prores_create='python2.7 /data/production/pipeline/linux/scripts/prores_create.py'
alias vrscene_submit='python2.7 /data/production/pipeline/linux/scripts/vrscene_submit.py'
alias vray_export='python2.7 /data/production/pipeline/linux/scripts/vray_export.py'
alias copy_to_delivery='python2.7 /data/production/pipeline/linux/scripts/copy_to_delivery.py'
alias make_symlink='python2.7 /data/production/pipeline/linux/scripts/make_symlink.py'
alias extract_exr_rgb='/data/production/pipeline/linux/scripts/exrExtractRGB/exrExtractRGB'
alias file_sync='python2.7 /data/production/pipeline/linux/scripts/sync_file.py'








What is the best way to do development work?

First create a local sandbox for your code. You only need to do this once. Get the latest code from
the github repository. Always work locally, and version your code by checking it in to the github
repository.

Set up you own local workspace env by including the /data/production/pipeline/linux/common/var/env_dev
environment variable file in your ~/.bashrc instead of the “env” file. This will ensure that all your
paths point to your local sandbox and not to the live code repository. As a result, when you test your
code, you will be running code in your local sandbox. When you are confident to roll it out to the
studio, copy this code over to the corresponding folder in the live code directory.

The contents of what a local ~/.bashrc should look like can be found in /data/production/pipeline/linux/common/docs/workstation_setup.pdf







          

      

      

    

  

    
      
          
            
  
Cron Jobs


What is a cron?

A cron is a scheduled task. It is linux utility which schedules a command or a script to run
automatically at a specified time and date.




What are the scheduled cron jobs at Loco?

Crons running on the CPT server

The cape town server runs sync crons run every evening. To access the cron file, first ssh onto the
server with:

ssh root@192.168.2.5
password: server





Then access the cron file with the command:

crontab -e





The file opens up in the terminal:

# Minute   Hour   Day of Month       Month          Day of Week        Command
# (0-59)  (0-23)     (1-31)    (1-12 or Jan-Dec)  (0-6 or Sun-Sat)

# This cron runs everyday at 5pm in CPT
# Sync all shots for osg_szm. Exclude img, playblasts, playblast and movies dirs
0 17 * * * rsync -auvzrh --exclude=io --exclude=playblasts --exclude=playblast --exclude=img --exclude=movies --progress /data/production/osg_szm/shots/E1 --exclude=plates root@192.168.0.210:/mnt/production/osg_szm/shots/ > /tmp/rsync_sm_shots_$(date +\%Y\%m\%d\%H\%M\%S).log 2>&1

# Sync all shots for osg_szm. Exclude img, playblasts, playblast and movies dirs
0 17 * * * rsync -auvzrh --exclude=io --exclude=playblasts --exclude=playblast --exclude=img --exclude=movies --progress /data/production/osg_szm/shots/E2 --exclude=plates root@192.168.0.210:/mnt/production/osg_szm/shots/ > /tmp/rsync_sm_e2_shots_$(date +\%Y\%m\%d\%H\%M\%S).log 2>&1

40 17 * * * rsync -auvzrh --exclude=incrementalSave --exclude=io --exclude=playblasts --exclude=playblast --exclude=img --exclude=movies --exclude=plates --progress /data/production/vf_alone/shots root@192.168.0.210:/mnt/production/vf_alone/ > /tmp/rsync_alone_shots_$(date +\%Y\%m\%d\%H\%M\%S).log 2>&1

# Sync assets of osg_szm. Exclude movies, vrscenes, incrementalSave and tmp dirs.
30 17 * * * rsync -auvzrh --exclude=incrementalSave --exclude=io --exclude=playblasts --exclude=playblast --exclude=img --exclude=movies --exclude=tmp --exclude=photogrammetry_data --exclude=render_images --exclude=*.vrscene --exclude=*.mov --exclude=*.tmp  --progress /data/production/osg_szm/assets root@192.168.0.210:/mnt/production/osg_szm/ > /tmp/rsync_osg_szm_assets_$(date +\%Y\%m\%d\%H\%M\%S).log 2>&1

# Change permissions of dirs and files for osg_szm
0 16 * * * find /data/production/osg_szm/ -exec chmod a+w {} \; > /tmp/osg_szm_chmod_log_$(date +\%Y\%m\%d\%H\%M\%S).log 2>&1

# Change permissions of dirs and files in vf_alone
15 16 * * * find /data/production/vf_alone/ -exec chmod a+w {} \; > /tmp/vf_alone_chmod_log_$(date +\%Y\%m\%d\%H\%M\%S).log 2>&1

# Start the rsync queue. Run through all files in /data/production/tmp_files
0 18 * * * /opt/scripts/rsync_queue > /tmp/rsync_queue_$(date +\%Y\%m\%d\%H\%M\%S).log 2>&1

# */1 * * * * echo "This is a cron" > /tmp/test_cron-$(date +\%Y\%m\%d\%H\%M\%S).log 2>&1





Crons running on the JHB server

ssh onto the file server in JHB with:

ssh root@192.168.0.210
password: server





Then access the cron file with:

crontab -e





The following file opens in the terminal:

# Minute   Hour   Day of Month       Month          Day of Week        Command
# (0-59)  (0-23)     (1-31)    (1-12 or Jan-Dec)  (0-6 or Sun-Sat)

# This is a hack, changing file permission of all files at 8pm everyday so we do not run
# into file permission issues.
# Change file permission for osg_szm
0 20 * * * find /mnt/production/osg_szm/ -exec chmod a+w {} \; > /tmp/osg_szm_chmod_log_$(date +\%Y\%m\%d\%H\%M\%S).log 2>&1

# Start the rsync queue. Run through all files in /mnt/production/tmp_files
30 18 * * * /opt/scripts/rsync_queue > /tmp/rsync_queue_$(date +\%Y\%m\%d\%H\%M\%S).log 2>&1

# Kill all running rsync jobs at 9am everyday so that we do not slow down CPT network
0 9 * * * kill -9 `ps -ef | grep 'rsync' | grep -v grep | grep -v $$ | awk '{ print $2 }' | xargs` > /tmp/rsync_jobs_killed_$(date +\%Y\%m\%d\%H\%M\%S).log 2>&1











          

      

      

    

  

    
      
          
            
  
Frequently Asked Questions


	
	How do I change permissions of my directory or file?

	Changing directory permissions:

# Open a terminal, sudo as root.
su
Password: locor00t
# chmod a+w <path of directory>
chmod a+w /data/production/rnd_pipeline/shots/001/001_0010/





Changing file permissions:

# Open a terminal, sudo as root.
su
Password: locor00t
# chmod a+w <path of file>
chmod a+w /data/production/rnd_pipeline/shots/001/001_0010/scene/layout/001_0010_v01.mb











	Why do I not see any ftrack actions?


First check to see if your ftrack-connect application is running on your computer.
You can check that here.

If ftrack-connect is running on your computer, then check to see the event server workstation is
running and connected to the network.

If the computer is running, then check to see if the supervisor daemon is running on the machine.
You can check this by running:

# Open a terminal and type
ssh root@192.168.0.153
Password: locor00t
# restart the supervisord service
service supervisord restart
exit










	How do I check if a file exists on JHB/CPT file server?


I am in JHB, how do I check if a file exists in CPT?
Open a terminal and run:

ssh server@192.168.2.5
Password: server
# all production file are located at /data/production/
# cd to change directory
# ll to list contents of a directory
cd /data/production/rnd_pipeline/shots/001/001_0010/
ll
# result
total 12
drwxr-xr-x 5 server server 4096 Oct 17 14:50 img
drwxr-xr-x 7 server server 4096 Jan 12 15:44 scene
drwxrwxr-x 7 server server 4096 Oct 20 10:33 shotAssets
ll /data/production/rnd_pipeline/shots/001/001_0010/scene/layout/001_0010_v01.mb
# result
-rw-rw-rw- 1 server server 102604 Oct 17 16:35 /data/production/rnd_pipeline/shots/001/001_0010/scene/layout/001_0010_v01.mb
exit





I am in CPT, how do I check if a file exists in JHB?
Open a terminal and run:

ssh admin@192.168.0.153
Password: loco
# all production file are located at /data/production/
# cd to change directory
# ll to list contents of a directory
cd /data/production/rnd_pipeline/shots/001/001_0010/
ll
# result
total 12
drwxr-xr-x 5 server server 4096 Oct 17 14:50 img
drwxr-xr-x 7 server server 4096 Jan 12 15:44 scene
drwxrwxr-x 7 server server 4096 Oct 20 10:33 shotAssets
ll /data/production/rnd_pipeline/shots/001/001_0010/scene/layout/001_0010_v01.mb
# result
-rw-rw-rw- 1 server server 102604 Oct 17 16:35 /data/production/rnd_pipeline/shots/001/001_0010/scene/layout/001_0010_v01.mb
exit










	
	I can’t access HQueue, what do I do?

	The hqueue web page can be accessed by going to http://192.168.0.153:5000 in your web browser.
This page is slow and takes a while to load, but if takes exceptionally long or if you get a “Page
Not Found” error, then you can restart the hqueue service by opening a terminal and typing the
following commands:

ssh root@192.168.0.153
Password: locor00t
cd /opt/hqueue/scripts/
./hqserverd restart
exit











	
	What do I do if one of the clients is down on the hqueue page?

	Go to the CLIENTS [http://192.168.0.153:5000/clients] page in HQueue. This is at

Any client called ‘render’ is a render farm machine. If one of these clients is red, then it means
that the client is unavailable. This happens if there is a disruption in the hqueue client process
running on the render farm machine.

[image: _images/offline-client.png]
In this example, render20 is offline. We can bring it back online by ssh’ing to the machine.
The IP address of the machine is written next to the name. In this case it is 192.168.0.230.
Run the following commands:

ssh root@192.168.0.230
Password: locor00t
service hqclientd restart
# if for whatever reason, the above command doesn't run, then run the script directly
/home/admin/hqclient/hqclientd restart
# Result of both those commands will look like
Stopping HQ client process.
Starting HQ client process/

...successfully started the HQ client process.
exit





Once the service has started, you will notice the client go green on the hqueue client page.

[image: _images/online-client.png]






	
	There is a task on ftrack, but I don’t have the corresponding folder or file on disk

	This could be one of 2 reasons, either the task’s type was not selected correctly or it is a
permissions issue.
If a task’s type is wrong, first correct the type in Ftrack.

[image: _images/task-type.png]
If it is a file permissions issue, first correct the directory permissions as described above.
Then create a folder with the same name as the task in the shot structure. Copy the template file
from /data/production/<your_project>/template_files/<task_file> to your task folder. Rename the
file to <shotname>_<version>.<ext eg. E1_010_0010_v01.mb







	
	The asset type is wrong on Ftrack, what do I do?

	The asset type determines the asset folder on disk. So for asset Earth, if type is environment,
then the asset will be created under /data/production/<project>/assets/environment/Earth
If the asset type is prop, then the asset will be created under /data/production/<project>/assets/prop/Earth

[image: _images/asset-type.png]
So if the asset type is wrong, your asset folder has been created incorrectly on disk.
In such a situation, first change the asset type on ftrack. Then simply move the folder to the
correct asset type folder.










Note

Asset types and task types are important as events are triggered based on the type. If the
type is wrong, then a folder may be created in the wrong place on disk or the wrong template
file may be copied over. So when creating a new task or asset, use the ‘Create’ menu in ftrack

[image: _images/create-menu.png]
and make sure to select the correct type from the drop down menu.

[image: _images/create-type.png]



	How do I check how many Nuke licenses are in use?


In your browser go to http://192.168.0.208:4102/
Click on the ‘Status’ button in the column on the left.
Then click on “foundry” under the “License Usage” column in the table.

[image: _images/foundry_usage.png]
Then in the page that opens, click “Get License Usage” button

This will display a table of all licenses currently in use for hiero, nuke and mari.

[image: _images/licenses.png]
The host in the above table is the hostname of the computer. You can find out the hostname of
your computer by going to System -> About this Computer.

[image: _images/hostname.png]
In this example, hostname is dev-pc
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Client Review Session

The client will receive an email invite to the review session.

[image: _images/client-email.png]
Click on the link called “View on ftrack review” to open the review session.

[image: _images/client-join.png]
Click on “Join Session” button to start the review.

[image: _images/client-session.png]
The bottom panel shows all the shots that are available for review. Click on the shot to load it.
Use the playback buttons to play, stop and step through the frames.

[image: _images/client-playback.png]
If the shot is approved, just click on the green approve button on the top left corner and
move on the to the next shot in the timeline.

[image: _images/client-approve.png]
If the shot requires changes, you can click on the “Require Changes” button.
You can also add notes and annotations to the shots that require changes.

To create an annotation, use the annotation tool box on the top right.

[image: _images/client-annotations-tool.png]
Create an annotation on the frame using the above tool bar, save the annotation.
Then add a note/comment in the comments column on the right and click on Post.

[image: _images/client-notes.png]
This will save your annotation and notes.

Here’s a quick gif to demonstrate the process.

[image: _images/client-annotation.gif]
Once you’re done with the review, click on the sign out button on the top right corner of your session.


Note

It is important that you sign out of the session. This will ensure you’ve securely
signed out and all your changes will be saved. If you do not sign out correctly, your
review feedback will not be saved.
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